
Here is a great tool to help you get experience faster, by trading on a simulated market. You can enter and exit trades like you would in a real 
market, so it gives you a more realistic feeling. 

You can speed it up, and slow it down as well. I have been able to practice trade a month in about 1 hour using this tool.

The system runs in MetaTrader 4

When learning to trade, there's no substitute for experience. A trader who has spent many months trading a live market will h ave a feel for the 
market that is almost impossible to explain. 

They will see the pitfalls in some stuations by just recognising similar price action. If you have this experience, you will know exactly what I'm 
talking about, if you don't have it yet, you wont. 

A live market is very different from looking back through charts or backtesting. When you backtest, you can see the bars that are coming, and 
there is no real stress involved. It's easy to see what signals would have worked, and which ones did not. When it comes to t rading for real, you 
can't see what's coming, and that is a very different dynamic indeed.

Using this tool, you can trade a few months in only a few hours and then easily print out the results, and see how you well y ou did. You can also 
make mistakes and recognise them in a safe situation. 

Granted it's not as real as using live money but its 10 times more realistic than backtesting. If you treat it as a challenge , it actually creates a pretty 
realistic view of how well you could potentially do with any system or method.

I personally think it's the second best learning aid there is. Number 1 is live trading but that can be expensive!

NOTE: Please Vote/Vouch for this thread so it can be taken out of the under evaluation thred. Thanks!

Attached Files 

Trade_Simulator_Files.zip (37.4 KB, 6094 views)

Trade_Simulator_Installer.zip (120.0 KB, 6508 views)

Trade_Simulator_setup.pdf (376.4 KB, 13478 views)

Hi,

EA to  practice my trading on a demo account. I decided to share it on forexfactory!
Any questions are welcome.

• Use your keyboard to enter/exit trades with a pre-defined settings.
• Draw horizontal/trend lines on your chart to enter and exit trades with a pre-defined settings.
• EA takes screenshots of the instances of when you enter the trade or exit the trade, so that you can study them later.
• Draw a line anyhow you want, whether it's a horizontal line or trendline tool. When price reaches it, it will alert you.
• More EA features to be added later on...

What does it do?

• You need the below 2 attachments for the EA to work:
• "Save" the "Strategy Developer EA" file into the LocalDisk_C/Mt4_Directory/experts folder.
• "Save" the "Strategy Developer DLL" file into the LocalDisk_C/Mt4_Directory/experts/include folder.
• Restart your MetaTrader 4.0 Platform.
• In options, make sure your MT4 allows DLL.

How to run the EA:

• PHP Code:
extern bool   Take_ScreenShots=true,
              Alert_On_Line_Entry=true,
              Email_On_Line_Entry=true;
extern int    SecondsBetweenAlerts=5;

Input features of the Expert Advisor:

Trade Simulator V-Hands

http://www.forexfactory.com/showthread.php?t=60849

Advanced metatrader
Thursday, March 31, 2011
8:08 AM
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extern double LotSize=0.1;
extern int    Slippage=100,
              SafetyStopLoss=30,
              SafetyTakeProfit=30;
extern color  TextColor=Red,
              LinesInfoColor=Orange,
              ShorcutsColor=Yellow,
              AccountInfoColor=RoyalBlue,
              AccountAnalyzeColor=Violet;
extern bool   Show_Broker_Time=true,
              Show_Line_Shortcuts=true,
              Show_Trade_Shortcuts=true,
              Show_Account_Text=true;
extern string FontStyle="Calibri";
extern int    FontSize=11.5;

• More input features to be added later on...

• In EA inputs, set your pre-defined properties.
• Shortcut keys: Press "alt+b" to buy. Press "alt+s" to sell. Press "alt+b+e" to buy exit. Press "alt+s+e" to sell exit. Press "alt+d" to delete 

trade objects. Press "alt+d+a" to delete all manual objects drawn on chart and the trade objects.
• To see EA screenshots, go to: LocalDisk_C/Mt4_Directory/experts/files/screenshots folder.
• To get alerts off of lines, create a horizontal/trend line on the chart. After that, go to its properties. Then, in the "name " part, type in 

"alert_above" (meaning when price above, then alert) or "alert_below" (meaning when price below, then alert). When a line is hit, an 
alert will go off every "SecondsBetweenAlerts" seconds (this is an external parameter) until you delete the line. Multiple alert lines can 
be created. For example, if you would like another "alert_above", name the 2nd one "alert_abovebrownfox"...just make sure 
"alert_above" is first in the string of the name part.

• To enter trades off of horizontal/trend lines, create a line on the chart. Then, go to its properties. After that, in the "na me" part, type in 
"buy_above" (meaning when price above, then buy) , or "buy_below" (meaning when price below, then buy) , or "sell_above" (meaning 
when price above, then sell), or "sell_below" (meaning when price below, then sell). When that named line is placed, it will turn blue and 
when it is breached and traded on, it will turn red. You can also set the "Alert_On_Line_Entry"/"Email_On_Line_Entry" parameter to true 
to alert/email you when price trades on the horizontal/trend line. Only 1 buy entry and 1 sell entry line allowed simultaneously.

• More EA features coming soon...

How to use the Expert Advisor in trading:

• Don't over-command the EA, for example: pressing keys to buy and then pressing keys to exit the buy(even though EA didn't buy yet).
• When exiting the buy trade, for example, press alt+b+e, but make sure not to press alt+b in accident to now open the buy agai n. Any 

suggestions to make this easier for anyone: please do share.
• More coming soon...

Tips:

Here is a glimpse of the chart using SOME of the awesome features:
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Here is how the screenshots will help you analyze your trades. You can see your buy open and buy exit in this example here:
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That's pretty much it. I hope it's helpful for most of you members here!
If you have any questions, feel free to ask them. 

If you have any suggestions for the EA, feel free to share them!

Oksana17.
Attached Files 

Strategy Developer v2.ex4 (26.0 KB, 490 views)

Strategy Developer DLL.ex4 (848 Bytes, 476 views)

MT4 navigational tips and techniques

(NEW MATERIAL IN RED TYPEFACE)

Hi all

The following post used to be a sticky in the MetaTrader forum, but it appears to have been lost. Hence I'm re -posting it here.

Use of the mouse and mousewheel, and their keyboard equivalents

Scrolling the chart
Hold down the left mouse button and drag the mouse in the main chart area, to scroll left/right.
Or you can also simply roll the mousewheel down/up, or use the left/right arrow keys, to likewise scroll the chart view left/ right.
To scroll a whole screen at a time, use Page Up (scroll left) and Page Down (scroll right). 
To reposition to the leftmost bar on the chart, press Home.To reposition to the most recent (rightmost) bar, press End.
To step forward one bar at a time, press F12.
To step backward one bar at a time, press Shift-F12.
Scrolling a chart beyond the leftmost bar will add historical bars to the beginning of the chart, until no more are available from MT4's 
historical database.

Moving directly to a certain date/time
To re-position immediately to a certain date, press Enter, then type in the date in the form DD.MM.YY and press Enter again. Leading 
zeros can be omitted (e.g. to move to 4 July 2005, type 4.7.5). To re-position to a certain date/time, use the format HH:MM or 
DD.MM.YY HH:MM (e.g. to position to 8:07am TODAY on a 1-min chart, simply type 8:7).

You can also use the "Fast Navigation Box" to change either the currency symbol, or the period, thus:

Code:
1. time (hours:minutes)         example: 08:30; 8:30;   
2. date                         example: 2004.10.16; 16.10.2004; 16.10.04;   
3. date and time                example: 2004.10.16 8:30; 16.10.2004 8:30; 16.10.04 8:30;   
4. symbol                       example: GBPUSD; EURUSD;   
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4. symbol                       example: GBPUSD; EURUSD;   
5. chart period                 example: M1; M5; M15; M30; H1; H4; D1; W1; MN;   
6. symbol, chart period         example: GBPUSD, M30; EURUSD, D1;

Vertical zoom and re-scale
You can re-scale the chart vertically by moving the mouse into the vertical axis area at the right of the screen, and then dragging 
downwards (with the left button held down) to compress the chart bars, or dragging upwards to expand them.
Double click to reset the chart to its original scale.

Horizontal zoom and re-scale
Similarly, you can adjust the width of the price bars by moving the mouse into the horizontal axis area at the bottom of the screen, and 
then dragging right (zoom in) or left (zoom out). Or simply use the "+" and "–" keys to achieve this.

Indicators
Double-click on or near indicators with the left mouse button, to call their parameter setup windows. 
Right-click to call the indicator's context menu.

If the screen is cluttered with overlapping indicators and/or objects, making it too difficult to select the desired indicato r, press Ctrl-I to 
call up the Indicators dialog window. Double click (or click the Edit button, or Alt-E) on the indicator to edit its properties (parameters, 
colors, etc), or click the Delete button (or Alt-D) to remove it from the chart.
You can use the Home, End and Page/arrow Up/Down keys to navigate up/down the list.

Objects
Double-click on or near an object (line studies, texts, arrows, geometric shapes) to select the object. Once selected, you can move an 
object by left clicking on it (or in the case of or trendline or shape, it's center handle) and dragging it to the desired de stination. Shapes, 
trendlines, channels etc may be extended by dragging the handles on the relevant edges. The number "X/Y" appears, where "X" = the 
width of the shape in candles, and "Y" = the height of the shape in pips.
Right-click on a selected object to open its context menu.

If the screen is cluttered with overlapping indicators and/or objects, making it too difficult to select the desired object(s ), press Ctrl-B to 
call up the Objects dialog window. Left click the check boxes on/off to select/deselect relevant object(s). Double click (or click the Edit 
button, or Alt-E) on an object to edit its properties (parameters, colors, etc), or click the Delete button (or Alt-D) to remove it from the 
chart. To quickly delete a whole block of objects, repeatedly press Alt-Dor hold it down (careful, they disappear rather quickly!)
You can use the Home, End and Page/arrow Up/Down keys to navigate up/down the list.
Click on the 'Name' or 'Description' heading area to sort by name, or description, respectively.
Left-click to select an item. You can use Ctrl-click to add individual items to a selection, Shift-click to add a group of consecutive items, or 
press Ctrl-A to select all items. Then click the Edit button (or press Alt-E) to edit all items in the group consecutively, or the Delete button 
(or press Alt-D) to delete all selected items simultaneously (careful!).

Alternatively, from the chart window, press Backspace repeatedly to delete the most recently added object(s) on a last-added-first-
removed basis (useful if you want to quickly check out a Fibo or regression channel, then remove it). Then press Ctrl-Z to undo any 
accidental deletes, in reverse order.
Or press the Delete key to remove ALL SELECTED objects.

Parallel Trendlines
Ctrl + left click on a selected trend line to draw a parallel trend line (create a channel). Can also be used with vertical and horizontal lines.

Duplicating objects
The 'Parallel Trendlines' concept extends to ALLobjects (vertical, horizontal and trend lines; shapes - triangle, square, ellipse; text and 
labels; arrows and symbols; and studies like channels, Fibo, Gann, Pitchfork, etc). Here's how to duplicate any object:

-- Select the object by clicking on it**
-- While holding down the Ctrl key: move the mouse over any one of the object's handles, and, holding down the left button drag the 
mouse to where you want the duplicated object to be located

This shortcut also duplicates all of the proprties of the parent object, e.g. if you have red, green and blue objects, and yo u want to create 
a green one, simply duplicate it. This is quicker than creating a new object, and then changing its color to green.

** Object selection options
Press Ctrl-O and then select the 'Objects' tab.

-- "Select object by single mouse click" - if checked OFF, you must double click to select an object, and right click to modify its properties. 
If checked ON, single click to select an object, and double click to modify its properties.

-- "Select object after creation" - if checked ON, any object is automatically selected immediately after you create it.

-- "Show properties after creation" - if checked ON, the property modification window for the object is displayed, immediately after you 
create the object.

OR

Press Ctrl-B to display the objects list. Click on the checkbox (at left) for each object you want selected.
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Press Ctrl-B to display the objects list. Click on the checkbox (at left) for each object you want selected.

Information Bubble
Hover the mouse cursor on or over an element, object or indicator to see the prompt (help information bubble).

Crosshair mode, and ruler tool
Click the mousewheel to switch cursor to the "crosshair" mode.
This can also be achieved by pressing Ctrl-F, or selecting the crosshair icon from the toolbar. The crosshairs also display vertical (price) 
and horizontal (date/time) co-ordinates at the right and bottom of the chart. 
Simply left-click to exit crosshair mode.

Now, here is something extremely useful that I haven’t found in the on-line help:
While in crosshair mode, hold down the left mouse button and drag the mouse to obtain a ruler-type tool that measures vertical 
(number of pips) and horizontal (number of bars) from the center of the crosshairs. The tool displays counters in the form "A /B/C" 
where A is the number of bars right or left of the crosshair, B is the number of pips from crosshair to cursor, and C is the price at the 
cursor.

I find "B" extremely useful for measuring the number of pips between any two points, thus:
1) move the mouse to the point you want to measure from (the "anchor" point);
2) click the mousewheel to enter crosshair mode;
3) then hold down the left button and move the mouse to any number of destination points, to see the number of pips between t he 
anchor point and the current mouse destination.
This saves having to calculate this distance manually, as the difference between two prices. Pretty cool!
You can also use this facility to count price bars (reading "A") between any two dates/times.

Reference and anchor points
At the lower left of the chart there is a dark colored arrow. Dragging it with the mouse sets the reference (anchor) point fo r the chart. 
Now when you zoom in or out, or even change the timeframe, this point remains anchored at its existing location.

At the upper right of the chart there is likewise a dark colored arrow. Drag it left or right with the mouse to set the locat ion for the last 
(most current) bar on the chart (i.e. set the amount of empty "whitespace" at the right of the chart).

Removing all indicators and objects from your chart
Load a blank chart (the pair/timeframe doesn't matter), then change the settings (press F8) to set colors, grid, etc to suit your 
preference. Then save this as a template named (for example) Z. (menu option: Charts > Template > Save Template……)
Then, whenever you want to instantly remove all indicators and objects from your chart, simply load template Z, by quickly us ing the 
hotkey combination: Alt-C T Z

List of hotkeys

There are many other useful hotkeys. Here is a comprehensive list:

Left arrow — scroll chart to the left;
Right arrow — scroll chart to the right;
Up arrow — quickly scroll chart to the left or (if the scale is defined), scroll chart upwards;
Down arrow — quickly scroll chart to the right or (if the scale is defined), scroll chart downwards;

Numpad 5— restores chart vertical scale to its original default. If the scale was defined, this returns the chart back to its visible r ange;

Page Up — scroll a whole screen to the left;
Page Down — scroll a whole screen to the left;
Home— move the chart to the start point (first bar);
End — move the chart to the end point (last, i.e. most current) bar;

"–" — zoom out (there are 6 levels of zoom available);
"+" — zoom in;

Delete — delete all selected objects;
Backspace — delete most recently added objects, on a last-added-first-removed basis;

Enter — open/close the fast navigation window;
Esc — close any dialog window;

F1— open the on line help "Userguide";
F2— open the "History Center" window;
F3— open the "Global Variables" window;
F4— open MetaEditor;
F5— switch to the next profile;
F6— call the "Tester" dialog window for testing the expert attached to the chart window;
F7— call the properties dialog window of the expert attached to their chart window, in order to change its settings;
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F8— call the chart setup dialog window, allowing basic chart parameters, colors, etc to be changed;
F9— call the "New Order" window, allowing the entry of market, limit, stop orders;
F10 — open the "Popup prices" window;
F11 — enable/disable full screen mode;
F12 — scroll the chart one bar to the left;

Shift+F12— scroll the chart one bar to the right;
Shift+F5— switch to the previous profile;

Alt+1 — display the chart as OHLC bars;
Alt+2 — display the chart as OHLC candlesticks;
Alt+3 — display the chart as a line (closing prices only);

Alt+A — copy all test/optimization results onto the clipboard;
Alt+W — call the chart management window;
Alt+F4— exit the program;

Ctrl+A — arrange all indicator window heights by default;
Ctrl+B— call the "Objects List" dialog window;
Ctrl+C or Ctrl+Insert — copy to the clipboard;
Ctrl+D— open/close the "Data Window";
Ctrl+E — enable/disable the attached expert advisor;
Ctrl+F — switch to "Crosshair" mode;
Ctrl+G — show/hide the vertical/horizontal grid;
Ctrl+H— show/hide the OHLC line;
Ctrl+I — call the "Indicators List" dialog window;
Ctrl+L — show/hide volume data on the main chart;
Ctrl+M — open/close the "Market Watch" window;
Ctrl+N — open/close the "Navigator" window;
Ctrl+O — open the "Setup" window;
Ctrl+P — print the chart;
Ctrl+R— open/close the "Tester" window;
Ctrl+S — save the chart prices (OHLCV) in a file having extensions: "CSV", "PRN" or "HTM";
Ctrl+T— open/close the "Terminal" window;
Ctrl+W or Ctrl+F4 — close the chart window that's currently in focus;
Ctrl+Y— show/hide date (period) separators;
Ctrl+Z or Alt+Backspace — undo object deletions in the reverse order they occurred;

Ctrl+F6— switch to the next chart window;
Ctrl+F9— open the "Terminal — Trade" window and switch the focus into it, allowing trading operations to be entered via the keyboard.

Attaching indicators to indicators outside of the main price chart
You can attach moving averages and other indicators to indicators on other than the main chart. For example, if you want to u se a 
moving average to smooth RSI, do the following:
1) Create a lower window with RSI in the normal manner.
2) Open the navigator window (press Ctrl-N).
3) Click on the "Indicators" heading in the Navigator window, if necessary, to expand it.
4) Move the mouse to the "Moving Average" item, then (holding down the left button), drag it (a rectangle appears under the arrow 
cursor) into the RSI window.
5) In the ensuing dialog box, got to the "Apply to" drop down, and set this to "First indicator's data". This will cause the MA to be 
attached to the first indicator in this window, i.e. the RSI.
6) Adjust other parameters as desired, and press Enter.

NOTE: 
-- To create an indicator in a separate window, right-click on its name in the Navigator, and select "Attach to a chart". 
-- To create an indicator in the same window as another, drag it's name into the relevant window.

Adding custom-defined indicators to MT4
One of the most powerful MT4 features is that it has a comprehensive but friendly programming language that allows custom -defined 
indicators, scripts and expert advisors to be written. Here's how to import an already written indicator into MT4's charting facility:

1) Go to a web resource that has the source code for the indicator. A good one is http://www.xeatrade.com/trading/11.html
Note the "# A B C D E F G H I J K L M N O P Q R S T U V W X Y Z" index.
So if you want to add (for example) the PPCI indicator to your charts, click on "P" to see all the custom-developed indicators starting with 
a "P".
Left-click on the PPCI hyperlink. The source code for PPCI appears in the middle of the screen. Left -click inside this window, then press 
Ctrl-A to select all of the text, then Ctrl-C to copy it.

2) Return to MT4, and press F4 to load the MetaEditor, a tool which allows to create and compile your own indicators, scripts and 
experts.
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3) In MetaEditor, press Ctrl-N to create a new indicator using the Expert Advisor Wizard.
Select the "Custom Indicator" radio button, and click Next.
Type in the name (e.g. PCCI) that you want to use to reference your indicator in MT4, ignore the other fields, and click Next .
On the final dialog window, ignore all fields, and click Finish.

4) Now left-click in the body of the screen, press Ctrl-A to select all the text, and then press Ctrl-V to paste the text you copied back in 
step 1, completely overwriting the previous text.

5) Then press F5 to save and compile your indicator.

Hopefully, the message "0 error(s), 0 warning(s)" will appear, indicating a "clean compile", i.e. that the programmer wrote the source 
code correctly, without syntax errors. Press Esc to close the dialog box.

Presto! If you now return to MT4, the new custom indicator should automatically appear both in the Navigator, and also under the menu 
option "Insert > Indicators > Custom" if you prefer to add it to your chart in this manner.

You can also add scripts and experts in the same way.
In step (1), select the "MQ4 Scripts" or "MQ4 Experts" hyperlink in the left menu.
In step (3), select the appropriate radio button.

Note that these objects are stored in the following folders:
Experts: c:/program files/<mt4 broker name>/experts

Scripts: c:/program files/<mt4 broker name>/experts/scripts
Custom indicators: c:/program files/<mt4 broker name>/experts/indicators
Include (program code, e.g. .MQH) files: c:/program files/<mt4 broker name>/experts/include
Templates: c:/program files/<mt4 broker name>/templates
Data files: c:/program files/<mt4 broker name>/experts/files

NOTE: As an alternative to the above, if you simply copy the .MQ4 file into the relevant folder, and then (exit and) re -start MT4, the 
expert, script or indicator will automatically be recompiled, and appear in the Navigator.

Some other good sources for MT4 indicators (apart from FF's search facility): 
http://www.forexfactory.com/showthread.php?t=62722 (see ZIP file attached to post #1)
http://www.forex-tsd.com (perform a forum search)
http://codebase.mql4.com/ (peform a site search)
http://www.forexmt4.com/_MT4_Indicators/
http://www.greattradingsystems.com/f...-4-indicators/

If you want to delete an expert, script or indicator (CAREFUL!), use Windows Explorer to go to the appropriate folder, and de lete the 
relevant file with the EX4 extension. For example, if you decide that you no longer want to use PCCI, delete file PCCI.EX4
That will effectively remove PCCI from the custom indicators list in MT4

The file PCCI.MQ4 contains the source code for PCCI (which you copied from the web resource), the PCCI.EX4 file is the execut able code 
that was created when you did your compile back in step (5). If you want to re -instate the indicator, all you need to do is reload the 
source into MetaEditor (press Ctrl-O and open the relevant file), and then press F5to compile it, which re-creates the executable file 
used by MT4.

A more simple way of deleting an expert, script or indicator is by using the Navigator (press Ctrl -N). Click on the item you wish to delete, 
press the DELETE key, and click Yes to confirm the deletion. Note that this deletes both the source (.MQ4) and executable (.EX4) files.

Happy charting!
David

Footnote: the above is repeated in the attached Word doc. If you prefer, you can download the doc, add your own notes to it, and/or 
print it out for handy reference.

NOTE: More tips here.
Attached Files 

MT4 navigational tips and techniques.doc (112.0 KB, 1904 views)

Secrets of MetaTrader 4 Client Terminal [ ru | cn ]

Press on F11 to switch to the full-screen mode.
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• Ctrl+M - Market Watch
• Ctrl+N - Navigator
• Ctrl+T - Terminal
• Ctrl+D - Data window

In the full-screen mode, the following hotkeys can be used to open command windows:

To return to the normal mode, just press F11 again.

***
Indicators, experts and/or scripts can be promptly attached to the chart if hotkeys are preliminarily 
set for them.
This can be very useful in the full-screen mode.
To assign hotkeys, select the "Set hotkey" option in the "Navigator" window context menu.

You can select any keys combinations you wish.
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***

For better positioning of the chart on the necessary time, you can use the Fast Navigation line.
To open the fast navigation line, press the spacebar or Enter or move the cursor to the left bottom part 
of the chart window and, after the sign

appears, double-click with the left mouse button.

Do not forget to disable the chart auto scroll.

• [time (hours:minutes)]
example: 8:30

• [date]
example: 2004.10.16

• [date] [time]
example: 16.10.04 8:30

Format of commands in the Fast Navigation line for precise positioning of the chart:

Using the fast navigation line, one can promptly switch between the chart's symbols and periods. This 
can be very useful in the full-screen mode.

• [symbol name]
example: GBPUSD

Format of commands in the Fast Navigation line for switching between symbols and/or periods of the 
chart:
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example: GBPUSD
• [chart period]

example: M30
• [symbol name],[chart period]

example: GBPUSD,M30
To execute a fast navigation command, press Enter. To cancel it, press Esc. Only one of the above 
commands can be executed in the fast navigation line at a time. 

***

A double click with the left mouse button on the "Terminal" window title bar will minimize it to the 
bar of the current account status.
Thus, some additional space will be free for the chart. You can also minimize the window by double-
clicking with the left mouse button on the title of any tab in the window.
To restore, double-click in the minimized window or select the "Restore" command in the context menu.

***

Frequently used indicators/scripts/experts/accounts can be added to the "Favorites" group to have a 
faster access to them.
To do so, click with the right mouse button on the name of the indicator/script/expert/account and 
select the command "Add to favorites".

The listed items will be available in the "Favorites" tab of the "Navigator" window.

***

The traffic can be saved if the unused symbols are hidden.

1. Select the "Hide All" command in the context menu of the "Market Watch" window.
2. Select the symbol using the left mouse button and press Delete.
3. Select the "Symbols" command in the context menu of the "Market Watch" window and 

hide/show symbols in the window that appears.

The symbols can be hidden in several ways:

• there are open positions or pending orders for this symbol
• the chart has been opened within the current session
• this symbol is used to recalculate cross rates

The symbol cannot be hidden if

***

Traffic will be saved if news are disabled.
To do so, open the "Tools -> Options" menu and unflag the "Enable news" field in the "Server" tab.
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***

You can create several sets of symbols and switch between them, if necessary.
This can be very useful if you work with different groups of symbols (currency pairs, shares, futures, 
etc.). Hide all "excessive" symbols and save the set obtained. 

***

The Popup prices window can be opened by pressing F10. 
If you select "Always on the Top" in the context menu of this window, you will be able to watch quotes 
while working with other applications.

Having selected "Properties..." in the context menu of the Popup prices window, you can adjust its 
colors and fonts:
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***

Background and bars colors, indicators and objects can be made the same for all charts.
To do so, adjust any chart as you wish: set colors, superpose objects, attach indicators, etc. Then select 
the "Charts -> Template -> Save Template..." menu and save the obtained template as default.tpl

From this moment, the template will apply to all newly opened charts. 

• chart type and color
• colors
• chart scaling
• the presence of the OHLC line
• the attached expert advisor and its parameters
• the superposed custom and technical indicators with their settings
• line studies
• separators of days

The following can be saved in a template:

***

Specific templates can be created for charts opened from the Tester and for those opened 
independently.
To create a default template for charts opened from the Tester, you have to save the template as 
"tester.tpl".
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For independent charts, the default template must be "offline.tpl". 

If the "offline.tpl" template is not found when the chart is opened independently, the "default.tpl" 
template is used. On no "tester.tpl", the embedded settings are used.

***

If you have several accounts, you can create a special profile for each.
At switching between accounts, the profiles will be opened automatically.
To create such a profile, you have to save it under the name which is exactly the same as the account 
number.
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number.

***

To call the "Crosshair" object, click the middle button of the mouse or press Ctrl+F.
This can be very useful when working in the full -screen mode. 

***

You can check vertical distances and the amount of bars between two points using the ruler.
To do so, select the "Crosshair" object, click with the left mouse button on the first point in the chart 
and drag the cursor to the second point.

The first number (23) is the count of bars, the second number (157) is the vertical distance in pips, the 
third number (1.8705) is the bid price in the second point.

***

Use F12 to page through the chart bar by bar.
This function can be very useful when you develop and test your own trading strategy. Just open the 
chart at the very beginning of the history (press Home) and page through it bar by bar.
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Shift+F12 will page through the chart backward.

***

Closed positions and deleted pending orders can be displayed in the chart.
To do so, go to the "Account History" tab in the "Terminal" window and drag the order to the chart using 
the left mouse button. It is necessary that the symbol history of the selected order is downloaded from 
the server. If the order is dragged to another symbol chart, it will be replaced with the selected symbol 
chart.
The order is displayed in the chart as order opening and closing/deleting arrows joined with a trendline 
segment. StopLoss and TakeProfit levels are displayed in the vertical line with the open price.

If Shift is pressed at the moment of dragging, all positions for the symbol of the selected order available 
in the "Account History" tab will be displayed.

***

There is no need to remember conditions, on which the type of pending orders to be placed depends.
Just click with the right mouse button on the desired point in the chart where you would like to place 
the order and select the "Trading" command in the context menu. You will see the types of pending 
orders that can be placed in this selected point.
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After one of the types has been selected, the window of order creation/modification with partly filled 
fields will open. It just remains to specify Stop Loss and/or Take Profit values.
Chalk Up

• Buy Limit — the current price level is above the value of the order to be placed.
• Buy Stop — the current price level is below the value of the order to be placed.
• Sell Limit — the current price level is below the value of the order to be placed.
• Sell Stop — the current price level is above the value of the order to be placed.

Pending orders can be of four types:

***

To modify Stop Loss and/or Take Profit, double-click on one of these fields in the order line.

After that, enter necessary values in the newly opened window.

***

If you have deleted an object by accident, press Ctrl+Z to undo. 
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***

Charts closed by accident can be reopened with all their settings using the "File -> Open Deleted".

***

Press Ctrl+P to print out a chart.
The chart is printed black and white by default, but it can also be printed in color. Just check the "Color 
print" field in the "Charts" tab of the "Tools -> Options" menu.
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Improved multi-timeframe/offset/chart period converter, P4L PeriodCon.mq4 
P4L PeriodCon.mq4 (2009-Nov-13; Updated v1.8 2009-Dec-10: ~160 downloads)
* As one user put it, the “gold standard” for generating offline charts.
* All “offline” charts are updated real-time (so long as the source-TF chart remains open)
* Generates non-standard MT4 chart timeframes (e.g. M10, H2, ...)
* Ability to timeshift any chart by any #hours/minutes. (e.g. Daily+1H, H4-2H, ...)
* Ability to generate charts with periods > 1-Month
( Please note: Many indicators work on such charts without modification, but some might require changes to work with non -
standard timeframes and/or timeshifted charts).

New very cool CandleTime and session time Clock indicators
P4L Clock.mq4 (2008-Sep-26. Updated v2_5 2010-Jan-14: ~1200 downloads)
* Display correct current time for up to ~18 world market timezones
* Different highlight color used during Market Open hours
* Control over syntax: AM/PM vs. 24hr. Optional “:SS”.
* Display “Bar Left:” (bar remaining time)
* Display Broker and local time
* Times are correctly adjusted by independent ST/DST dates-per-timezone
* At a glance, compare Broker time accuracy vs. your own CPU clock. 
(Display “:SS”. This is very helpful when expecting high-impact news events at exact moments).
* Optional background rectangle beneath labels can COVER price bars for readability
P4L CandleTime.mq4 (2008-Sep-26; Updated v1_2 2009-Nov-13: ~1100 downloads)
* Displays the bar-remaining time next to the current bar.
* Indicates “WAIT4BAR:-MM:SS” (i.e. a new bar expected but no tick yet)
* (opt) Displays the bar-remaining time as a comment (top-left corner)

Much improved P4L OrderHistory.mq4 script to display trade history on charts
P4L OrderHistory.mq4 (was “OrderHistory V2.mq4”) (2007-Sep-13; Updated 2010-Jan-11: ~1050 downloads)
* Display your trade history (and/or open orders) graphically.
* Arrows mark open & close events. Trendlines drawn from open->close price. Optional texts.
* Calculates profit/loss in standard pips. (... even on extra-digit brokers).
* Detect and mark certain kinds of slippage. 
* Combine trade history from multiple brokers! (first output, then use as input)
* Output trade history as a CSV file to import into Excel
* Include ALL trade history, or limit by date-range. 
* Output file can include ALL symbols, or just current chart symbol.

Add price to Fibo levels automatically using Set_Fibo_Price_Any_V2.mq4
Set_Fibo_Price_Any_V2.mq4 ( 2007-Oct-31: ~2700 downloads)
* Annotate each Fibo (or Expansion) level with the price 
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http://www.forexfactory.com/showthread.php?t=206301
http://www.forexfactory.com/showthread.php?t=109305
http://www.forexfactory.com/brokers.php
http://www.forexfactory.com/showthread.php?t=46668
http://www.forexfactory.com/showthread.php?t=54134


Additional  Links for metatrader indicators

http://www.forexfactory.com/showthread.php?t=47055
http://www.myfxwealth.com/downloads/metatrader-indicator-downloads/
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